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Reference to the whole or to part of this volume should be made as follows: 
Print citation for Chapter 1:
Shipboard Scientific Party, 2002. Leg 198 summary. In Bralower, T.J., Premoli Silva, I., Malone, M.J., et 
al., Proc. ODP, Init. Repts., 198: College Station TX (Ocean Drilling Program), 1–84.

CD-ROM volume citation:
Bralower, T.J., Premoli Silva, I., Malone, M.J., et al., 2002. Proc. ODP, Init. Repts., 198 [CD-ROM]. 
Available from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2002. Site 1207. In Bralower, T.J., Premoli Silva, I., Malone, M.J., et al., Proc. 
ODP, Init. Repts., 198, 1–143 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: October 2002

The mailing dates of recent Proceedings of the Ocean Drilling Program:

Volume 195 (Initial Reports): July 2002
Volume 196 (Initial Reports): May 2002
Volume 197 (Initial Reports): August 2002
Volume 173 (Scientific Results): August 2001
Volume 175 (Scientific Results): March 2002
Volume 180 (Scientific Results): September 2002

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:
Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).
The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Some close-up photographs of very dark cores have been tonally enhanced to better illustrate 
particular features of interest.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is the view of a sunrise from aboard the JOIDES Resolution by ODP photographer 
John Beck.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 

coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 16 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
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http://www-odp.tamu.edu/
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http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs); smear slide, thin section, and sedimentary thin section data tables; 
and digital core images are included in this section. ASCII versions of the smear slide and sedimentary 
thin section data tables are also available (see “ASCII Tables”).

Site 1207

Visual Core Descriptions · Smear Slides · Thin Sections
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Site 1210

Visual Core Descriptions · Smear Slides · Thin Sections
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of the structural geology data table and of the smear slide data 
tables and thin section data tables presented under “Core Descriptions.” A complete listing of the  
ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 

menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Smear slide data tables Thin section data tables 
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Smear Slide Data Tables
Site 1207 smear slide table.

Site 1208 smear slide table.
Site 1209 smear slide table.
Site 1210 smear slide table.
Site 1211 smear slide table.
Site 1212 smear slide table.
Site 1213 smear slide table.
Site 1214 smear slide table.

Thin Section Data Tables
Site 1207 sedimentary thin section table.
Site 1210 sedimentary thin section table.
Site 1213 sedimentary thin section table.
Site 1213 igneous rocks.
Site 1213 metamorphic rocks.
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CD-ROM CONTENTS: OVERSIZED FIGURES
Chapter 11, Figures F7 and F8 are printed on the oversized foldout that is located in the front pocket 
of this publication. Figures F7 through F14 are available as oversized figures in PDF format on the 
Initial Reports CD-ROM included with this publication.

Chapter 11, Figure F7. Top: Seismic lines (5A and 5C) collected over the North High showing the 
location of Site 1207. Bathymetric map displays the location of all North High seismic lines collected; 
bold white lines show the location of seismic lines 5A and 5C. Bottom: Seismic lines (8 and 11B) 
collected over the Central High showing the location of Site 1208.

Chapter 11, Figure F8. Seismic lines (14A, 14C, 17A, and 17B) collected over the South High showing 
the locations of Sites 1209, 1210, 1211, 1213, and 1214. Bathymetric map shows the locations of all 
the South High seismic lines collected.

Chapter 11, Figure F9. Top: Seismic line 3 collected over the Thompson Trough on the Papanin 
Ridge. Bottom: Seismic line 4 collected during the transit from the Thompson Trough to the North 

High survey area.

Chapter 11, Figure F10. Seismic lines 5B and 6 collected over the North High. Middle and bottom: 
Seismic line 7 collected during the transit from the North High to the Central High.

Chapter 11, Figure F11. Seismic line 9 collected over the Central High.

Chapter 11, Figure F12. Top, middle, and bottom: Seismic lines 10, 11A, and 11C collected over the 
Central High.

Chapter 11, Figure F13. Top: Seismic lines 12 and 13 collected during the transit from the Central 
High to the South High. Middle and bottom: Seismic lines 14B and 14C collected over the South 
High.

Chapter 11, Figure F14. Top and middle: Seismic lines 15 and 16 collected over the South High. 
Bottom: Seismic lines 17C and 17D collected during the transit from the South High to Guam.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF.

ODP Leg 198 Site Map 

ODP Map (Legs 100–198)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 198 
depth-shifted and processed downhole logging data and shipboard core logging data (gamma ray 

attenuation bulk density, magnetic susceptibility, natural gamma radiation, P-wave velocity, moisture 
and density, and color reflectance). The downhole logging data are provided by the Borehole Research 
Group at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory of Columbia 
University, PO Box 1000, 61 Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-
3182; E-mail: borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173, 174B, 175, and 180. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

README.TXT

IR198_01.PDF (Leg 198 Summary)

ODPMAP.PDF
(ODP map, Legs 100 through 198)

CHAPTERS
(Volume chapters)

198_MAP.PDF
(Leg 198 site map)

IR198_02.PDF (Explanatory Notes)

IR198_03.PDF (Site 1207)

IR198_04.PDF (Site 1208)

IR198_05.PDF (Site 1209)

IR198_06.PDF (Site 1210)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(Data tables in ASCII format of 
smear slide data and thin section data)

S_SLIDES (Sites 1207 through 1214)

T_SECT (Sites 1207,1210, and 1213)

README.TXT

OVERSIZE
(Large-format figures)

IR198_11 (Chapter 11 files)

COR_1207.PDF (Site 1207)CORES
(Visual core descriptions, smear
slide data tables, thin section data
tables, and digital core images)

COR_1208.PDF (Site 1208)

COR_1209.PDF (Site 1209)

IMAGES (PDF files of core images)

IR198_07.PDF (Site 1211)

IR198_08.PDF (Site 1212)

COR_1210.PDF (Site 1210)

COR_1211.PDF (Site 1211)

COR_1212.PDF (Site 1212)

IR198_11.PDF (Data Report: High-Resolution 
Site Survey Seismic Reflection Data for ODP Leg 
198 Drilling on Shatsky Rise)

IR198_10.PDF (Site 1214)

IR198_09.PDF (Site 1213)

WINDOWS

UNIX

MAC 

COR_1213.PDF (Site 1213)

COR_1214.PDF (Site 1214)

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

198IR.PDF
(Preliminary pages and table of contents)

VOLUME
(Leg 198 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

(Continued on next page)

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
198 Initial Reports)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)
ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program) NDX.PDX

(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

101NDX.PDF through 173NDX.PDF,
174BNDX.PDF, 175NDX.PDF, and 180NDX.PDF
(Index files)
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